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KATA PENGANTAR 

 

Puji syukur ke hadirat Tuhan Yang Maha Esa atas segala rahmat dan karunia-Nya, 

sehingga E-Modul ArcMap Dasar ini dapat disusun dengan baik. Modul ini disusun sebagai 

salah satu bahan ajar untuk membantu mahasiswa dan pembaca dalam memahami 

dasar-dasar penggunaan ArcMap sebagai perangkat lunak Sistem Informasi Geografis 

(SIG). 

E-Modul ini diharapkan dapat menjadi panduan praktis yang sistematis dan mudah 

dipahami, khususnya bagi pemula dalam mempelajari pengolahan dan analisis data 

spasial. Penyusunan modul ini juga disesuaikan dengan kebutuhan pembelajaran di 

bidang geografi, sehingga dapat mendukung peningkatan kompetensi mahasiswa dalam 

bidang SIG. 

Penulis menyadari bahwa modul ini masih memiliki keterbatasan, oleh karena itu kritik 

dan saran yang membangun sangat diharapkan demi penyempurnaan di masa yang akan 

datang. 

Akhir kata, semoga E-Modul ini dapat memberikan manfaat bagi pembaca dan dunia 

pendidikan. 

 

 

 

Tondano, Maret 2026 

Karina Meiyanti Maulana, S.Pd., M.Sc. 
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PETUNJUK PENGGUNAAN E-MODUL 

Cara Belajar Mandiri 

E-Modul ArcMap Dasar ini dirancang untuk mendukung pembelajaran secara mandiri 

(self-learning). Agar memperoleh hasil belajar yang optimal, pengguna diharapkan 

mengikuti petunjuk berikut: 

1. Pelajari Secara Bertahap 

Bacalah materi pada setiap bab secara berurutan, mulai dari konsep dasar hingga 

praktik penggunaan ArcMap. Jangan melompati materi agar pemahaman lebih 

sistematis.  

2. Pahami Tujuan Pembelajaran 

Setiap bagian modul dilengkapi dengan tujuan pembelajaran. Pastikan Anda 

memahami tujuan tersebut sebelum memulai, sehingga proses belajar menjadi 

lebih terarah.  

3. Ikuti Langkah Praktik dengan Teliti 

Perhatikan setiap langkah penggunaan ArcMap yang disajikan. Lakukan praktik 

langsung menggunakan perangkat lunak untuk memperkuat pemahaman.  

4. Gunakan Data Latihan 

Jika tersedia data latihan, gunakan sebagai bahan praktik agar Anda terbiasa 

mengolah data spasial secara mandiri.  

5. Kerjakan Latihan dan Evaluasi 

Kerjakan setiap latihan atau soal evaluasi yang diberikan untuk mengukur tingkat 

pemahaman Anda.  

6. Ulangi Materi yang Belum Dipahami 

Jika terdapat bagian yang sulit dipahami, ulangi kembali materi tersebut hingga 

benar-benar menguasainya.  

7. Manfaatkan Sumber Pendukung 

Anda dapat menggunakan referensi tambahan seperti buku, video tutorial, atau 

sumber daring lainnya untuk memperdalam pemahaman.  

8. Belajar Secara Konsisten 

Atur waktu belajar secara rutin agar proses pembelajaran lebih efektif dan tidak 

terburu-buru. 
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CAPAIAN PEMBELAJARAN 

 

Daftar indikator keterampilan ArcGIS yang relevan dengan capaian pembelajaran Mata 
Kuliah Sistem Informasi Geografis (SIG): 

1. Pengoperasian Dasar ArcGIS 

CPL terkait: CPL-6, CPL-7, CPL-14 

Indikator: 

a) Mampu membuka dan membuat project di ArcGIS  

b) Mampu menambahkan (add data) layer spasial  

c) Mampu mengenali jenis data (vektor & raster)  

d) Mampu mengatur tampilan layer (on/off, urutan layer)  

 

2. Input dan Editing Data Spasial 

CPL terkait: CPL-6, CPL-14 

Indikator: 

a) Mampu melakukan digitasi sederhana (titik, garis, poligon)  

b) Mampu mengisi dan mengedit tabel atribut  

c) Mampu menambahkan field pada attribute table  

 

3. Pengelolaan Data Sederhana 

CPL terkait: CPL-6, CPL-14, CPL-17 

Indikator: 

a) Mampu melakukan penyimpanan data dengan benar  

b) Mampu melakukan editing sederhana (update/delete data)  

c) Mampu memastikan data siap digunakan (tidak error dasar)  

 

4. Pembuatan Peta Sederhana 

CPL terkait: CPL-7, CPL-18 

Indikator: 

a) Mampu membuat peta tematik sederhana  

b) Mampu memberi simbol (warna/simbol berbeda) pada data  

c) Mampu menambahkan elemen peta (judul, legenda, skala)  

d) Mampu menampilkan peta dengan rapi  

 

5. Analisis Spasial Dasar 

CPL terkait: CPL-6, CPL-10, CPL-14 

Indikator: 

a) Mampu melakukan query sederhana (berdasarkan atribut)  

b) Mampu melakukan buffering sederhana  

c) Mampu melakukan overlay sederhana (clip/intersect dasar)  

d) Mampu membaca hasil analisis secara sederhana  
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6. Penyajian Hasil (Output) 

CPL terkait: CPL-11, CPL-18 

Indikator: 

a) Mampu mengekspor peta (PDF/JPEG)  

b) Mampu menyimpan hasil kerja secara sistematis  

c) Mampu menjelaskan peta yang dibuat secara sederhana 
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BAB I 

Pengenalan ArcGIS dan Konsep Dasar SIG 

Tujuan: Mahasiswa memahami dasar SIG sebelum praktik 

 

A. Pengertian Sistem Informasi Geografis dan ArcGIS 

Sistem Informasi Geografis (SIG) atau Geographic Information System (GIS) 

merupakan sistem berbasis komputer yang digunakan untuk mengelola informasi 

yang memiliki referensi geografis atau spasial. Menurut Burrough (1986), SIG adalah 

sistem berbasis komputer yang digunakan untuk memasukkan, menyimpan, 

mengelola, menganalisis, dan menampilkan data geografis. Definisi lain menyatakan 

bahwa SIG merupakan sistem yang mengintegrasikan perangkat keras, perangkat 

lunak, data, dan manusia untuk mengelola serta menganalisis informasi geografis. 

Dalam penelitian, SIG juga dijelaskan sebagai sistem informasi yang bekerja dengan 

data spasial dan non-spasial untuk menghasilkan informasi berbasis keruangan. 

ArcGIS merupakan salah satu perangkat lunak SIG yang sering digunakan dalam 

banyak bidang yang menggunakannya. Dilansir dari Esri, ArcGIS merupakan platform 

geospasial yang komprehensif bagi professional dan organisasi. ArcGIS 

dikembangkan oleh Esri. ArcGIS mengintegrasikan dan menghubungkan data melalui 

konteks geografis. ArcGIS menyediakan kemampuan untuk membuat, mengelola, 

menganalisis, memetakan dan membagikan berbagai jenis data spasial dan non 

spasial. Beberapa fungsi utama ArcGIS yaitu pemetaan, analisis spasial, pengolahan 

data geografis, visualisasi data spasial, serta pendukung pengambilan keputusan 

berbasis lokasi. 

SIG dan ArcGIS tidak dapat dipisahkan. SIG sebagai sebuah konsep/sistem yang 

kemudian dapat dibantu oleh aplikasi pendukung seperti ArcGIS untuk 

memvisualisasikan konsep/teori yang dipelajari dalam bidang SIG. Meskipun ArcGIS 

merupakan aplikasi pendukung, namun sangat perlu untuk dikuasai agar membantu 

kita dalam melakukan analisis/pengambilan keputusan. ArcGIS merupakan 

implementasi teknologi dari konsep SIG yang dapat dimanfaatkan dalam banyak 

bidang, seperti perencanaan wilayah, lingkungan, kebencanaan, transportasi 

maupun penelitian geospasial lainnya.  
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B. Jenis Data Spasial 

Dalam SIG, terdapat dua jenis data spasial yang dapat direpresentasikan sebagai data 

vector dan raster.  

a. Data vektor 

Dalam format data vektor, permukaan bumi direpresentasikan sebagai kumpulan 

elemen geometris yang terdiri atas garis (arc/line), poligon (area yang dibatasi oleh 

garis yang titik awal dan akhirnya sama), titik (point yang memiliki atribut tertentu), 

serta node (titik pertemuan atau perpotongan antar garis). 

Keunggulan utama dari data vektor terletak pada kemampuannya dalam 

merepresentasikan objek spasial seperti titik, batas wilayah, dan garis secara presisi. 

Hal ini menjadikan format vektor sangat sesuai untuk analisis yang memerlukan 

tingkat akurasi posisi yang tinggi, seperti pada pengelolaan data batas kadaster. 

Selain itu, data vektor juga efektif dalam menggambarkan hubungan spasial antar 

fitur geografis. 

 

Gambar 1. Data Vector 

Namun demikian, salah satu kelemahan utama dari format vektor adalah 

keterbatasannya dalam merepresentasikan fenomena yang mengalami perubahan 

secara bertahap (gradual), seperti variasi ketinggian atau suhu. Data vector 

selanjutnya pada ArcMap disebut sebagai Shapefile (.shp) (Puntodewo, dkk. 2003). 

 

b. Data Raster 

Data raster, yang juga dikenal sebagai data berbasis grid, umumnya dihasilkan dari 

teknologi penginderaan jauh. Dalam format ini, objek geografis direpresentasikan 
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dalam bentuk kumpulan sel yang disebut piksel (picture element). Tingkat resolusi 

atau ketajaman visual pada data raster sangat ditentukan oleh ukuran piksel. Artinya, 

setiap piksel merepresentasikan luasan tertentu di permukaan bumi, sehingga 

semakin kecil ukuran area yang diwakili oleh satu piksel, maka semakin tinggi 

resolusi data tersebut. 

Data raster sangat efektif digunakan untuk menggambarkan fenomena yang berubah 

secara bertahap (gradual), seperti jenis tanah, tingkat kelembapan, vegetasi, maupun 

suhu permukaan. Namun, kelemahan utama dari format ini adalah kebutuhan ruang 

penyimpanan yang besar, terutama jika menggunakan resolusi tinggi. 

 

Gambar 2. Data Raster 

Secara umum, setiap format data memiliki kelebihan dan kekurangan masing-

masing. Pemilihan jenis data, baik vektor maupun raster, sangat bergantung pada 

tujuan penggunaan, ketersediaan data, volume data, tingkat ketelitian yang 

diharapkan, serta kemudahan dalam proses analisis. Data vektor cenderung lebih 

efisien dalam hal ukuran file dan memiliki tingkat presisi lokasi yang tinggi, tetapi 

kurang fleksibel dalam pengolahan matematis. Sebaliknya, data raster memerlukan 

kapasitas penyimpanan yang lebih besar dan memiliki ketelitian posisi yang relatif 

lebih rendah, namun lebih mudah digunakan dalam analisis berbasis perhitungan 

matematis (Puntodewo, dkk. 2003). 
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C. Pengenalan Antarmuka/Interface ArcGIS 

Tampilan awal ketika membuka aplikasi 

 

Tampilan menu utama aplikasi 

 

Setiap aplikasi pada PC/Laptop masing-masing dapat berbeda, sesuai pengaturan 

toolbar/menu yang ditampilkan.  
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Menu utama 

 

Pada menu utama ini, setiap PC/Laptop sama.  

 

Toolbar  

 

Toolbar pada masing-masing PC/Laptop kemungkinan tidak sama posisi dan jumlahnya. 

Toolbar dapat disesuaikan kebutuhan masing-masing, dapat diaktifkan dan dinon-
aktifkan dengan klik kanan pada bagian toolbar yang kosong, seperti berikut: 

 

Apabila sudah terceklis, berarti tools sudah aktif di interface utama, dan sudah bisa 

digunakan. Begitupun sebaliknya.  
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Menu File  

 

Menu Edit 

 

 

 

 

 

Pada menu file, terdapat pilihan untuk membuat file 

baru (New), membuka file yang sudah ada (Open), 

menyimpan file (Save, Save As, Save a Copy), 

membagikan file (Share As), menambahkan data (Add 

Data), dan pengaturan-pengaturan lainnya terkait file. 

Ketika file ArcMap disimpan, akan tersimpan dalam 

ekstensi .mxd 

Apabila ingin membagikan file mxd, bisa 

menggunakan Share As dan akan dibagikan dalam 

bentuk Map Package (.mpk)  

Pada menu edit, terdapat Undo, Redo, Cut, Copy, 

Paste dan seterusnya dengan fungsi yang sama 

dengan aplikasi lainnya.  
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Menu View 

 

Menu Insert 

 

 

 

 

 

 

 

Pada menu view, terdapat Data View untuk tampilan 

editing, dan Layout View untuk tampilan tahap akhir 
pembuatan peta yaitu proses layout.  

Data frame properties, digunakan untuk pengaturan 

dasar dari frame yang akan digunakan, seperti 

pengaturan sistem koordinat, nama layer, satuan 

koordinat, dll.  

Pada menu insert, akan banyak digunakan pada 

proses layouting peta (tahap akhir) seperti 

menambahkan teks, legenda, arah mata angin, skala 
batang dan skala angka, gambar, dll. 
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Menu Selection 

 

 

Menu Geoprocessing 

 

Menu Customize 

 

 

Pada menu Selection, membantu pengguna untuk 

memilih data berdasarkan atribut, lokasi ataupun 

bentuk. Bisa membantu menemukan objek dari 

atribut ke bentuk, atau lokasi. Menu ini akan aktif 

selama proses editing data vector.  

Pada menu Geoprocessing, terdapat beberapa alat 

analisis geospasial sederhana untuk data vector, 

seperti memotong, menggabungkan dengan berbagai 

metode atau kegunaan. Untuk mencari alat analisis 

tingkat lanjutan atau yang lebih banyak, dapat 

membuka ArcToolbox.  

Pada menu Customize, digunakan untuk 

mengatur tampilan toolbar, maupun 

ekstensi, dan pengaturan ArcMap yang 
digunakan.  
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Menu Windows 

 

 

 

 

 

 

 

Table of Contents 

  

 

 

  

Table of contents (biasanya sebelah kiri, dan dapat 

dipindahkan posisinya sesuai kebutuhan pengguna), 

berfungsi untuk menampilkan layer/data yang ada 

pada aplikasi. Table of contents dapat diaktifkan pada 
menu Windows.  

Pada menu Windows, digunakan untuk 

menampilkan Table of Contents, Catalog 

(penyimpanan PC/Laptop), Search, dan 

Image Analysis (analisis cepat untuk data 
vector dan raster).  
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BAB II 

Pengoperasian Dasar ArcMap 

Tujuan: Mahasiswa mampu menggunakan ArcGIS secara dasar 

 

A. Menambahkan data 

Dalam menambahkan data vector maupun raster, dapat dilakukan melalui tools Add 

Data (File → Add Data → Add Data) atau pada gambar tools berikut.  

 

Atau langsung mengakses folder yang ada pada PC/Laptop melalui Catalog (Windows 

→ Catalog).  

 

 

Untuk menyambungkan Add Data ke folder tertentu/folder penyimpanan data, bisa 

disambungkan melalui Folder Connections. Setelah ditambahkan ke dalam folder 
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connection, selanjutnya tidak perlu menambahkan kembali folder tersebut karena 

sudah tersambung.  

 

 

Contoh tampilan folder yang sudah connect pada aplikasi.  
 

B. Mengatur layer  

Pada contoh tampilan layer dibawah, yang terdiri dari beberapa data vector, dapat 

diatur urutan, dan aktif/tidaknya data dari Table of Contents. 

 

Untuk mengatur aktif/tidaknya data, dapat dengan mengaktifkan tanda centang atau 

tidak 
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C. Navigasi peta  

Navigasi muka peta dapat dilakukan dengan menggunakan tools berikut. 

 

 

Untuk zoom in dan zoom out muka peta, dapat menggunakan tools ini  

 

Untuk menggeser muka peta tanpa menggeser data, dapat menggunakan tools pan.  

 

Untuk memilih polygon tanpa menggeser data, dapat menggunakan tools Select by 

Attribute.  

 

Untuk melihat data atribut dari polygon tanpa membuka Attribute Table dapat 

menggunakan tools identify.   

 
 

  

Pada gambar disamping, menandakan seluruh data 

aktif pada Layers. Jika dinonaktifkan, data tidak akan 

ditampilkan pada muka peta.  

Apabila ingin dipindahkan urutannya secara vertical, 

dapat dilakukan dengan tarik dan tahan langsung 
data keatas/kebawahnya.  
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BAB III 

Input dan Editing Data Spasial 

Tujuan: Mahasiswa mampu membuat dan mengedit data 

 

A. Konsep digitasi  

Dalam proses digitasi pada aplikasi ArcMap, data vektor digunakan untuk 

merepresentasikan objek geografis secara digital dalam bentuk geometris. Data 

vektor terdiri dari tiga tipe utama, yaitu: 

 

a) Titik (point) 

Titik digunakan untuk merepresentasikan objek yang memiliki ukuran sangat 

kecil atau dianggap tidak memiliki luas pada peta. 

Contoh: lokasi sekolah, rumah sakit, sumur, atau menara.  

Dalam ArcMap, titik dibuat dengan satu koordinat (x, y).  

Biasanya digunakan untuk menunjukkan lokasi spesifik. 

b) Garis (line) 

Garis digunakan untuk menggambarkan objek yang memiliki panjang tetapi 

tidak memiliki luas. 

Contoh: jalan, sungai, rel kereta, atau jaringan listrik.  

Dibentuk dari kumpulan titik yang terhubung.  

Menunjukkan arah atau jalur suatu objek. 
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c) Polygon (area) 

Polygon digunakan untuk merepresentasikan objek yang memiliki luas atau area. 

Contoh: batas wilayah, lahan pertanian, danau, atau bangunan.  

Dibentuk dari garis yang tertutup.  

Menunjukkan area dengan atribut tertentu (misalnya jenis tanah atau 

penggunaan lahan). 

 

B. Membuat Data Baru 

Dalam membuat data vektor baru, dapat dilakukan melalui Catalog. Catalog → Pilih 

folder penyimpanan → Klik kanan → New → Shapefile, dan akan muncul tampilan 

sebagai berikut.  
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Pada jendela Create New Shapefile, dapat diatur Nama file yang akan dibuat (tanpa 

spasi). Feature type dapat dipilih sesuai kebutuhan ingin membuat shapefile dalam 

bentuk apa (Titik, Garis atau Polygon).  
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Kemudian memilih sistem koordinat pada bagian Spatial Reference → Edit …  

 

Setelah mengganti nama, jenis data yang akan dibuat dan sistem proyeksi, 

selanjutnya akan muncul tampilan seperti contoh berikut. 

 

 

 

Setelah muncul jendela Spatial 

Reference Properties, 

selanjutnya pilih sistem proyeksi 
yang akan digunakan.  

Contoh yang sering digunakan: 

1. WGS 1984 (Satuan 

decimal degrees, kurang 

cocok untuk menghitung 

luasan).  

2. WGS 1984 UTM Zone … 

(Satuan meters, cocok 

untuk menghitung 

luasan, Zona bergantung 

lokasi peta, dapat dipilih 

dan disesuaikan 

kebutuhan). 

Setelah diatur, dapat langsung 

oke dan shapefile sudah siap 

digunakan dan diedit sesuai 

kebutuhan. 
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C. Digitasi objek sederhana 

Sebelum melakukan digitasi objek, perlu dipastikan data shapefile sudah siap 

digunakan. Seperti contoh berikut. 

 

Pada Table of Contents, terdapat 3 data vector (shapefile) dan 1 data raster (data 

orthomosaic) yang akan menjadi dasar dalam melakukan digitasi objek.  

Data titik merupakan data infrastruktur, data garis merupakan jalan, dan data 

polygon merupakan blok bangunan.  

Perlu dipahami bahwa dalam membuat/mengedit data vector, perlu dilakukan 

aktivasi Editor terlebih dahulu. Editor → Start Editing. 
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Untuk memulai proses digitasi, perlu membuka jendela Create Features.  

 

Pada jendela Create Features, dapat dipilih jenis/tipe data yang akan dibuat terlebih 

dahulu. Pada contoh berikut, terdapat 3 data shapefile yang sudah dibuat 

sebelumnya.  

 

 

Contoh 1: membuat titik-titik infrastruktur yang ada pada Orthomosaic.  

 

Dari gambar diatas, dapat dilihat terdapat beberapa titik-titik biru yang merupakan 

hasil digitasi data titik pada data Orthomosaic.  



Page | 25  
 

 

Contoh 2: membuat garis jalan dengan membuat titik-titik yang bersambungan 

sehingga menghasilkan garis. 

 

Garis biru merupakan hasil digitasi data garis pada Orthomosaic.  

 

Contoh 3: membuat polygon pada blok bangunan dengan membuat titik-titik 

melingkari objek sehingga membentuk area/polygon.  

 

Dari gambar diatas, dapat dilihat proses (kiri) dan hasil (kanan). Polygon tersebut 

merupakan blok bangunan yang dibuat berdasarkan batas-batas seperti sungai dan 

jalan. Lanjutkan hingga seluruh Orthomosaic terdata.  

 

D. Mengisi, mengedit dan menambahkan field atribut 

Setiap data vector/shapefile, memiliki data atribut. Setelah membuat data secara 

spasial/visual pada muka peta, selanjutnya menambahkan data non spasial pada data 
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spasial dengan mengedit/mengisi data atributnya. Untuk mengisi data atribut, dapat 

dilakukan dengan Klik Kanan pada Data Shapefile → Open Attribute Table. 

 

Contoh tampilan data atribut dari data titik (infrastruktur) yang sebelumnya sudah 

dibuat. Pada jendela Table (kanan), dapat dilihat data belum terisi. Id dapat diisi dengan 

angka (1,2,3, dst). Untuk menambahkan keterangan lainnya sesuai kebutuhan, misal 

Nama objek, dapat dilakukan dengan Table Options → Add Field … (dengan catatan, 

Editing sudah di stop dengan membuka Editor → Save dan Stop Editing). Untuk 

menambahkan data isi tabel, harus melakukan Start Editing kembali pada Editor → Start 

Editing.  

 

 

Pada jendela Add Field, dapat diisi Nama (untuk kolom baru yang akan ditambahkan), 

Type dapat dipilih sesuai jenis data. Contoh, untuk mengisi tulisan/alfabet, maka pilih 

Text, untuk mengisi angka, maka pilih Double.  
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Contoh: menambahkan kolom nama objek pada tabel atribut 

 

Field properties merupakan jumlah karakter maksimal yang dapat terisi dalam 1 baris 

data. Pada contoh diatas (kiri), nama kolom merupakan Nama_obj, Tipe Text, dengan 
maksimal karakter 50.  

Pada gambar selanjutnya, menunjukkan hasil penambahan kolom yang dilakukan 

sebelumnya. Untuk mengisi tabel, aktifkan Editing terlebih dahulu.  

Contoh setelah tabel diisi berdasarkan titik data yang telah dibuat: 

 

  



Page | 28  
 

BAB IV 

PEMBUATAN PETA TEMATIK 

Tujuan: Mahasiswa mampu membuat peta tematik yang informatif 

 

Peta tematik adalah jenis peta yang dirancang untuk menampilkan tema atau informasi 

khusus pada suatu wilayah geografis. Berbeda dengan peta umum (seperti peta 

topografi), peta tematik fokus pada satu atau beberapa variabel tertentu, misalnya 

kemiringan lereng, kepadatan penduduk, curah hujan, penggunaan lahan, tingkat 

pendidikan, atau persebaran penyakit. Peta tematik digunakan untuk menganalisis pola, 

hubungan, dan distribusi fenomena tertentu di permukaan bumi. 

Contoh Peta Tematik yang akan dibuat pada modul ini adalah Peta Kemiringan Lereng 

dan Curah Hujan.  

A. Peta Kemiringan Lereng 

Peta kemiringan lereng (slope map) adalah peta tematik yang menunjukkan tingkat 

kemiringan atau kecuraman permukaan tanah di suatu wilayah. Kemiringan lereng 

biasanya dinyatakan dalam persentase (%) atau derajat (°), yang menggambarkan 

perbandingan antara perubahan tinggi (elevasi) dengan jarak horizontal. 

Peta ini umumnya dihasilkan dari data Digital Elevation Model (DEM). Terdapat 

beberapa jenis DEM dari satelit yang bisa digunakan dalam membuat peta 

kemiringan lereng, seperti: 

a) DEM SRTM (Shuttle Radar Topography Mission) dengan resolusi 30 meter. 

b) ASTER GDEM (Advanced Spaceborne Thermal Emission and Reflection 

Radiometer) dengan resolusi 30 meter. 

c) ALOS PALSAR dengan resolusi 5-30 meter. 

d) DEMNAS (Digital Elevation Model Nasional) yang dikeluarkan oleh Badan 

Informasi Geospasial (BIG) dengan resolusi 8 meter.  

Pada modul ini, akan digunakan DEMNAS sebagai data dasar dalam pembuatan peta 

kemiringan lereng. Adapun tahapan pembuatan peta kemiringan lereng pada modul 

ini dapat dilihat sebagai berikut.  
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1. Mengunduh data DEMNAS  

Data DEMNAS bisa diakses melalui website tanahair.indonesia.  

 

Untuk mengunduh data DEMNAS, pengguna terlebih dahulu harus masuk/daftar 

jika belum memiliki akun. Setelah masuk, kemudian bisa mengakses pada bagian 

Unduh Data → Data Demnas. 

 

Grid/kotak biru tersebut merupakan lembar DEMNAS yang dapat diunduh satu 

per satu sesuai kebutuhan/wilayah yang akan dilakukan pemetaan. Misalnya 

akan mengunduh salah satu, klik kotak dan akan muncul tampilan seperti berikut. 

https://tanahair.indonesia.go.id/portal-web/
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2. Membuka dan menggabungkan file DEMNAS di ArcMap 

Setelah proses unduh selesai, data kemudian dapat dilihat melalui ArcMap.  

 

Tampilan awal DEMNAS akan tampak seperti 

berikut 

 

Setelah muncul tampilan 

berikut, selanjutnya memulai 

proses unduhan lembar 
tersebut.  

Ketika menambahkan data 

DEMNAS ke ArcMap, akan 

muncul peringatan seperti ini, 

yang artinya data DEMNAS 

belum memiliki sistem 

koordinat sehingga harus 

diregistrasi terlebih dahulu satu 

persatu. ArcToolBox → Data 

Management Tools → 

Projections and 

Transformations → Raster → 
Project Raster.  (Pilih WGS 84) 
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Dari tampilan diatas, dapat dilihat bahwa DEMNAS belum tersambung meskipun 

lembarnya berdekatan, sehingga harus dilakukan proses mosaic untuk 

menjadikannya sebagai 1 layer yang tak terpisah.  

Buka ArcToolBox → Data Management Tools → Raster → Raster Dataset → 

Mosaic to New Raster. Akan muncul jendela seperti berikut. 

 

 

 

Dari jendela Mosaic To New Raster diatas, Input Raster diisi dengan DEMNAS 

yang akan digabungkan, isi folder penyimpanan, nama data yang akan dibuat 

dengan ekstensi (biasanya .tif), pilih sistem koordinatnya sesuai lokasi, pilih Pixel 
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Type 32_BIT_SIGNED (hal ini disesuaikan dengan spesifikasi data raster, berbeda 

disetiap raster), Number of Bands diisi 1, Mosaic Operator pilih Mean, dan Mosaic 

Colormap pilih Match. Setelah proses analisis selesai, akan muncul hasil seperti 

berikut.  

 

Dapat dilihat pada hasilnya, 4 DEMNAS yang sebelumnya terpisah, akan tampak 

menyatu seperti gambar diatas. Kemudian dapat dilanjutkan dengan melakukan 

analisis spasial untuk membuat kemiringan lerengnya. 

 

3. Membuat Kemiringan Lereng 

Untuk membuat kemiringan lereng, digunakan tools Slope yang bisa diakses 

melalui ArcToolBox → Spatial Analyst Tools → Surface → Slope, atau melalui 

Search bar dengan menulis kata kunci “Slope”. 

 

Setelah Slope dipilih, akan muncul jendela sebagai berikut. 

atau 
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Input Raster yang dipilih yaitu data DEMNAS yang sudah dimosaic sebelumnya, 

Output Raster yaitu folder penyimpanan beserta nama file dan ekstensinya (.tif), 

Output measurement disesuaikan dengan satuan kemiringan lereng yang ingin 

dibuat. Z factor perlu disesuaikan dengan letak lintang, pada 0⁰ nilai Z Factor yang 

digunakan yaitu 0,00000898. Pada modul ini digunakan satuan persen maka 

dipilih PERCENT_RISE. Adapun hasil dari analisisnya dapat dilihat sebagai 

berikut. 
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4. Melakukan Reclassify 

Dapat dilihat pada Table of Content, pada layer Slope.tif, terdapat keterangan 

warna yang menunjukkan persentase kemiringan lerengnya. Perlu untuk 

dilakukan klasifikasi kembali untuk menyesuaikan nilai kemiringan lereng 

dengan standar yang digunakan, seperti tabel berikut. 

No Kemiringan Lereng (%) Keterangan 
1. 0 – 8% Datar 
2. 8 – 15% Landai 
3. 15 – 25% Agak Curam 
4. 25 – 45% Curam 
5. >45% Sangat Curam 

Klasifikasi ulang persentase kemiringan lereng dilakukan dengan tools Reclassify. 

ArcToolBox → Spatial Analyst Tools → Reclass → Reclassify atau melalui Search 

bar dengan menuliskan kata kunci Reclassify. 

 

Setelah Reclassify dipilih, akan muncul jendela berikut. 

 

atau 

Input raster diisi hasil Slope, dan 

pada Reclassification pilih 
Classify …   
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Setelah pilih Classify, akan dilakukan pengaturan sesuai nilai kemiringan lereng 

yang dibutuhkan.  

 

Pilih Method Manual, dengan 5 Kelas. Aturan pembagian persentasenya dapat 

diatur pada bagian kanan bawah pada Break Values. Nilai terakhir dibiarkan saja 

karena kelas terakhir yaitu >45%.  

 

Setelah proses diatas selesai, hasilnya akan tampak sebagai berikut. 

Setelah classify selesai, akan 

muncul tampilan seperti 
berikut.  

Selanjutnya mengatur lokasi 

penyimpanan pada bagian 

Output Raster.  Tambahkan 

ekstensi .tif pada penamaan file 

raster.  
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Setelah proses reclassify selesai, selanjutnya dapat mengatur pewarnaan 

kelasnya dari hijau untuk landai dan merah untuk sangat curam. Dapat dilakukan 

dengan klik kanan pada bagian Reclassify.tif → Properties → Symbology → 

Classified.  

 

Pilih jumlah kelasnya 5, Color Ramp dari hijau ke merah, dan label diganti sesuai 

dengan kelas kemiringan lerengnya. Hasil akhirnya sebagai berikut. 
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5. Mengubah data Raster menjadi Vektor 

Untuk mengolah lebih lanjut data kemiringan lereng, dapat diubah dari raster 

menjadi vector (data shapefile) dengan cara ArcToolBox → Conversion Tools → 

From Raster → Raster to Polygon. 

 

Pada jendela Raster to Polygon, dapat disesuaikan seperti contoh berikut. 
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Hasilnya sebagai berikut. 

 

Data atribut dapat disederhanakan pada Attribute Table.  

 

B. Peta Curah Hujan 

Peta curah hujan adalah peta tematik yang menampilkan distribusi jumlah curah 

hujan di suatu wilayah dalam periode waktu tertentu (harian, bulanan, atau 

tahunan). Peta ini digunakan untuk menunjukkan pola sebaran hujan, baik secara 

spasial (ruang) maupun temporal (waktu).  

Data yang digunakan dalam membuat peta Curah Hujan yaitu data Curah Hujan yang 

dapat dihimpun dari berbagai sumber, misalnya dari Data Online BMKG dari Badan 

https://dataonline.bmkg.go.id/dataonline-home
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Meteorologi, Klimatologi, dan Geofisika, atau dari publikasi BPS (Kabupaten/Kota 

Dalam Angka), atau dari Balai Wilayah Sungai masing-masing daerah. Pada modul ini, 

data yang akan digunakan dari Data Online BMKG. Metode pemetaan curah hujan 

terdiri dari banyak metode, namun yang paling sering digunakan yaitu Spline, IDW 

dan Krigging.  

Adapun perbandingan untuk ketiga metode tersebut yaitu: 

Aspek IDW Spline Kriging 

Prinsip Jarak 
Kurva 
halus 

Statistik 
(variogram) 

Kompleksitas Rendah Sedang Tinggi 

Akurasi Sedang Sedang Tinggi 

Hasil Bullseye 
Sangat 
halus 

Realistis 

Cocok untuk 
Data 
merata 

Fenomena 
halus 

Data spasial 
kompleks 

Error 
estimate 

Tidak ada Tidak ada Ada 

Adapun metode yang akan digunakan pada modul ini yaitu Metode Kriging. Tahapan 

dalam pembuatan Peta Curah Hujan ini dapat dilihat sebagai berikut. 

1. Mengunduh data curah hujan 

Untuk mengunduh data curah hujan, dapat dilakukan pada website Data Online 

BMKG, dengan membuat akun.  
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Setelah login dengan akun, dapat mengunduh data pada menu Data Iklim → Data 

Harian dan akan muncul tampilan sebagai berikut. 

 

Mengisi parameter sesuai kebutuhan seperti contoh berikut. 

 

Tampilan data setelah diunduh dan dibuka pada Excel sebagai berikut. 

 

Parameter, Provinsi, Kab/Kota, 

Nama Stasiun dan Rentang 

Waktu dapat disesuaikan 
dengan kebutuhan. 

Klik Proses untuk dapat 

mengunduh data dalam bentuk 

.xls atau .pdf 

Terdapat informasi seperti 

lokasi lintang dan bujur, serta 
data CH harian.  

Dapat dilanjutkan dengan 

menginput koordinat lokasi 

stasiun dan nilai rerata CH.  
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2. Menginput Data ke Excel 

Sebelum melakukan analisis, perlu untuk menghimpun, dan menggabungkan 

data CH yang sudah diunduh ke Excel, dengan informasi nama stasiun, lokasi 

lintang dan bujur, serta nilai CHnya seperti gambar berikut.  

 

Menyimpan file Excel dengan tipe Excel 97-2003 Workbook  

 

Setelah menyimpan file, selanjutnya menambahkan data excel ke ArcMap 

 

Add Data sampai muncul Sheet 

tempat penyimpanan data di 

excelnya.  
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Selanjutnya, data titik koordinat akan muncul pada muka peta  

 

Klik kanan pada Sheet1 → 
Display XY Data …  

Mengisi data seperti gambar 

berikut, dengan menambahkan 

sistem koordinat pada bagian 

Edit di Coordinate System of 

Input Coordinate.  
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Pada gambar diatas, hanya terlihat 3 titik dikarenakan 2 titik sangat berdekatan 

sehingga tampak seperti 3 titik.  

Data titik tersebut kemudian diubah menjadi data vector (shapefile) dengan Klik 

Kanan pada Sheet1 Events → Data → Export Data …  

 

Setelah data diubah menjadi data vector, data atributnya menjadi seperti berikut. 

 

Selanjutnya, sebagai dasar dalam membuat peta interpolasi CH, dibutuhkan data 

lainnya seperti batas administrasi. Pada Latihan modul ini, ditambahkan Batas 

Provinsi Sulawesi Utara. 
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Data shapefile batas administrasi Sulawesi Utara sudah ditambahkan.  

3. Interpolasi nilai CH dengan metode Kriging 

Setelah data excel sudah bisa diakses menjadi data vector dengan atribut yang 

lengkap, selanjutnya dapat dilakukan analisis kriging untuk menginterpolasikan 

data Curah Hujan.  

Kriging dapat diakses melalui ArcToolBox → Spatial Analyst Tools → Kriging atau 

pada Search bar menuliskan kata kunci “Kriging”. 

 

Setelah memilih Kriging, akan muncul tampilan jendela sebagai berikut. 

 

 

atau 
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Mengatur Processing Extent menjadi Same as layer Sulut (menyesuaikan dengan 

batas administrasi yang digunakan). Klik Oke.  

 

Hasil dari analisis Kriging dapat dilihat sebagai berikut.  

Input point features 

pilih data CH, Z value 

field pilih kolom data 

yang berisi data CH. 

Output survace raster 

tambahkan lokasi 

penyimpanan dan 

ekstensi file (raster 
→ .tif). 

Selanjutnya, klik 

Environments … pada 

bagian bawah jendela 

Kriging. 
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Selanjutnya dapat dilakukan reclassify agar data CH lebih bagus dan merata 

disekitar stasiun pengukur CH. Dilanjutkan dengan proses merubah warna 

menjadi biru muda hingga biru tua, yang menandakan semakin besar nilai CH, 

maka semakin biru tampilan warnanya.  

 

Susun agar shapefile batas administrasi berada diatas Raster Reclassify. Select by 

Attributes pada Sulawesi Utara hingga tampilannya menjadi seperti berikut. 
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Setelah di-reclass dan diubah warnanya, kemudian memotong raster hasil 

reclassify agar hanya tampil pada daerah Sulawesi Utara khususnya pada pulau 

utama (Pulau Sulawesi). Dapat dilakukan secara cepat dan sederhana dengan 

tools Windows → Image Analysis. 

 

Pastikan shapefile batas administrasi sudah ter-select (biasanya garis pinggirnya 

berwarna tosca seperti gambar diatas), kemudian klik file Reclassify pada bagian 

atas Image Analysis, dan pilih Clip pada bagian Processing di bagian bawah Image 

Analysis. Setelah terpotong, hasil akhirnya akan menjadi seperti berikut. 
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Data Interpolasi CH siap digunakan dan dapat diubah menjadi data vector 

(shapefile).  

C. Panduan Layout Peta sesuai Kaidah Kartografis 

Layout peta adalah tampilan akhir dari suatu peta yang telah disusun secara visual 

dalam satu halaman dan siap untuk dicetak atau dipublikasikan. Layout ini tidak 

hanya menampilkan peta utama, tetapi juga dilengkapi dengan berbagai elemen 

penting seperti judul, legenda, skala, arah utara, sumber data, serta informasi 

tambahan lainnya yang membantu pengguna memahami isi peta. Dalam ArcMap, 

layout peta biasanya dibuat pada mode Layout View, di mana seluruh komponen 

peta diatur secara proporsional dan sistematis agar menghasilkan tampilan yang 

informatif dan menarik. 

Dalam penyusunannya, layout peta harus mengikuti kaidah kartografis karena 

peta pada dasarnya merupakan media komunikasi visual yang menyampaikan 

informasi geografis. Tanpa mengikuti kaidah tersebut, peta dapat menjadi sulit 

dipahami, menimbulkan kesalahan interpretasi, bahkan tidak layak digunakan 

dalam konteks akademik atau profesional. Sebaliknya, dengan menerapkan kaidah 

kartografis, peta akan menjadi lebih jelas, akurat, dan mudah dibaca sehingga 

pesan yang ingin disampaikan dapat diterima dengan baik oleh pengguna. 

Kaidah kartografis sendiri merupakan seperangkat aturan atau prinsip dalam 

pembuatan peta yang bertujuan untuk menghasilkan peta yang efektif dan 
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komunikatif. Prinsip-prinsip tersebut mencakup kejelasan (clarity), 

keseimbangan (balance), keterbacaan (legibility), penggunaan simbol dan warna 

yang tepat, akurasi data, kesederhanaan, serta adanya hierarki visual yang baik. 

Dengan menerapkan kaidah ini, peta tidak hanya menjadi alat penyajian data, 

tetapi juga menjadi media komunikasi yang mampu menyampaikan informasi 

spasial secara tepat, efisien, dan tidak menyesatkan. 

Adapun unsur-unsur yang harus ada pada peta yaitu: 

a) Judul peta = Menjelaskan isi atau tema peta secara singkat dan jelas 

b) Legenda = Menjelaskan arti simbol, warna, dan pola pada peta 

c) Skala peta = Menunjukkan perbandingan jarak di peta dengan jarak 

sebenarnya 

d) Arah utara (orientasi) = Menunjukkan arah untuk membantu pembacaan 

peta 

e) Sumber data = Menunjukkan asal data yang digunakan 

f) Tahun pembuatan peta = Menunjukkan waktu pembuatan untuk 

mengetahui keaktualan data 

g) Nama pembuat / instansi = Sebagai identitas dan tanggung jawab pembuat 

peta 

h) Garis koordinat (grid) = Menunjukkan posisi geografis (lintang dan bujur 

atau UTM) 

i) Inset map (peta lokasi) = Menunjukkan lokasi wilayah dalam konteks yang 

lebih luas 

j) Garis tepi (border) = Membingkai peta agar rapi dan jelas 

Proses Layout Peta dapat dimulai dengan mengubah Data View menjadi Layout 

View pada toolbar View → Layout View. Tampilan awal layout view akan berbeda-

beda, namun contohnya dapat dilihat pada gambar berikut.  
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Perlu dilakukan penyesuaian ukuran kertas untuk layout peta. Penyesuaian 

ukuran kertas dapat dilakukan dengan klik kanan bagian kertas → Page and Print 

Setup… Pada modul ini akan diubah menjadi kertas A4 dengan orientasi landscape 

 

Jika ingin menggunakan tipe kertas lainnya yang tidak ada pada pilihan Paper Size, 

dapat menghilangkan centang pada Use Printer Paper Settings, Standart Size akan 

menampilkan lebih banyak pilihan ukuran kertas. Setelah itu, mengatur posisi 

muka peta dan skala peta seperti gambar berikut. 
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Skala pada peta diatas diatur 1:100.000. Untuk menggeser muka peta di dalam 

kotak data, dapat dengan menggunakan tools Pan.  

Menambahkan grid pada muka peta, dengan cara klik kanan pada muka peta → 

Properties → Grids → New Grid… 
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Intervals pada gambar diatas dapat disesuaikan dengan skala peta masing-masing dan 

bisa disesuaikan kemudian jika ukurannya tidak pas. Klik Next hingga selesai dan Ok. 

Akan muncul tampilan sebagai berikut. 

 

Hasil diatas belum rapih sehingga perlu dilakukan penyesuaian pada bagian properties 

→ Grids → Properties → Ubah Intervals hingga pas → Labels → Label Orientation → 

Ceklis Vertical Labels Left dan Right. Hasil dari perbaikan intervals dan label orientation 

dapat dilihat pada gambar berikut.  
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Untuk menambahkan unsur peta lainnya, dapat menggunakan tools Insert. 

 

Gunakan garis bantu untuk mempermudah layout peta. Klik pada penggaris untuk 

menambahkan, dan tarik keluar penggaris untuk menghilangkan.  

1. Data Frame = untuk menambahkan data frame, 

bisa digunakan untuk menambahkan inset 

peta. 

2. Text = untuk menambahkan teks, bisa 

digunakan untuk menambahkan judul, sumber 

data, nama pembuat/instansi dan keterangan 

lainnya. 

3. Legend = untuk menambahkan legenda peta 

4. North Arrow = untuk menambahkan arah mata 

angin 

5. Scale Bar = untuk menambahkan skala batang 

6. Scale Text = untuk menambahkan skala angka 

7. Picture = untuk menambahkan gambar seperti 

logo instansi 
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Membuat teks judul (kiri), Change Symbol untuk menyesuaikan ukuran, jenis font dan 

warna (kanan).  

 

Menambahkan arah mata angin. 

 



Page | 55  
 

Menambahkan skala batang (kiri), dan mengatur tampilan skala batang (kanan) pada 

menu Properties. 

 

Menambahkan skala angka 

 

Tampilan sementara hasil layout. 

 



Page | 56  
 

Tambahkan inset peta pada Insert → New Data Frame. Tambahkan data vector/shapefile 

batas-batas administrasi sekitar lokasi pemetaan. Setelah ditambahkan data frame, 

tambahkan grids, dan judul Inset Peta, hingga tampilannya seperti gambar berikut. 

 

Tambahkan teks sistem proyeksi, datum, dan sistem grid. 

 

Menambahkan Legenda 

 

Klik Next hingga finish, dan menghasilkan tampilan berikut. 
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Perlu untuk dilakukan penyesuaian untuk mempercantik tampilan legenda, dan 

menghilangkan unsur-unsur yang tidak diperlukan. Klik kanan Legenda → Properties. 

Pada properties dapat diatur sesuai kebutuhan ukuran, font, posisi, dll. Gambar diatas 

(kiri) menunjukkan tampilan sebelum disesuaikan, dan gambar (kanan) menunjukkan 

tampilan setelah disesuaikan. 

Tambahkan keterangan sumber data. 

 

Tahap akhir, membuat garis tepi untuk memisahkan unsur-unsur peta yang ada pada 

tampilan peta. Dapat menggunakan Rectangle yang ada pada tools Draw.  

 

Tampilan awal rectangle akan tampil sebagai berikut. 
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Perlu untuk dilakukan penyesuian dengan klik kanan Rectangle → Properties → Fill Color 

diubah menjadi No Color. 

 

Lakukan untuk semua unsur hingga selesai. Tampilan akhir setelah garis tepi sudah 

dibuat untuk semua dapat dilihat sebagai berikut. 
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BAB V 

ANALISIS SPASIAL DASAR 

Tujuan: Mahasiswa memahami analisis sederhana 

 

Analisis spasial adalah proses pengolahan data geografis untuk menghasilkan informasi 

baru berdasarkan hubungan lokasi, jarak, dan atribut. Pada ArcMap, analisis ini dilakukan 

menggunakan tools Geoprocessing. Dalam analisis spasial, juga dikenal istilah Query. 

Query data atribut adalah proses menyeleksi atau memfilter data berdasarkan nilai 

atribut (tabel) tanpa mempertimbangkan lokasi geografisnya. 

A. Query 

Query dilakukan untuk menyeleksi atau memfilter data atribut berdasarkan kategori 

yang kita ingingkan.  

Membuka tabel atribut dengan klik kanan pada data vector/shapefile yang akan di-

query → Open Attribute Table. 

 

Misalnya, dari data Batas Desa satu Provinsi Gorontalo, hanya ingin memilih desa-

desa yang ada di Kecamatan/Kabupaten tertentu, maka akan melakukan proses 

query. Table options → Select By Attributes…  
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Pada bagian atas, terdapat judul-judul kolom yang ada pada tabel atribut data vektor. Pilih 

kolom mana yang akan ditampilkan. Misalnya, pilih Kabupaten (Klik 2x hingga muncul di 

kolom bagian bawah jendela) jika ingin menampilkan data Batas Desa yang ada di 

Kabupaten tertentu. Selanjutnya klik “Get Unique Values” gunakan Go To untuk mencari 

dengan keyword. Tambahkan penghubung dengan tanda =. Klik 2x pada nama Kabupaten 

yang akan dipilih sehingga hasilnya menjadi “KABUPATEN” = ‘GORONTALO’. Hasilnya 

akan menjadi sebagai berikut. 
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Apabila ingin menampilkan hanya hasil query, maka dapat dilakukan dengan Klik Kanan 

pada data vector/shapefile → Properties → Definition Query → Query Builder, dan 

lakukan hal yang sama dengan proses seperti diatas. Hingga hasil yang akan muncul 

sebagai berikut. 

 

 

B. Buffer 

Buffer adalah proses dalam analisis spasial untuk membuat zona atau area dengan 

jarak tertentu di sekitar suatu objek geografis (titik, garis, atau polygon). Misalnya, 

terdapat data titik yang akan dicari radiusnya sejauh 100 meter per titik. 

 

Untuk melakukan buffer, dapat melalui tools Geoprocessing → Buffer. 
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Akan muncul jendela sebagai berikut (kiri), dan bisa diisi sebagai berikut (kanan). 

 

Hasil buffer dapat dilihat pada gambar berikut. 
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Buffer dapat dilakukan pada tipe data lainnya, seperti garis dan polygon. Contoh garis 

sebagai berikut. 

 

Hasil buffer jalan 20 meter dari garis sebagai berikut. 

 

Contoh buffer pada data polygon sebagai berikut. 
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Hasil buffer 20 meter dari garis pinggir danau dapat dilihat sebagai berikut. 

 

 

C. Clip, Intersect, Union, Merge, dan Dissolve 

Clip digunakan untuk memotong layer berdasarkan batas layer lain. Clip berfungsi 

untuk membatasi area analisis, mengambil data sesuai wilayah tertentu. Sebagai 

contoh, memotong data penggunaan lahan berdasarkan batas kecamatan. Ilustrasi 

clip dapat dilihat pada gambar berikut. 
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Intersect menghasilkan area yang merupakan irisan dari dua atau lebih layer. 

Intersect berfungsi untuk menentukan area yang memenuhi beberapa kriteria 

sekaligus, misalnya menentukan daerah kawasan hutan, daerah rawan longsor, dll. 

Ilustrasi intersect dapat dilihat pada gambar berikut. 

 

Union menggabungkan seluruh area dari beberapa layer polygon menjadi satu layer 

baru. Union berfungsi untuk analisis kombinasi seluruh wilayah, dan tidak ada area 

yang dihilangkan. Misalnya, menggabungkan peta tanah dan penggunaan lahan untuk 

melihat kombinasi keduanya. Ilustrasi Union dapat dilihat pada gambar berikut. 
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Merge adalah proses menggabungkan beberapa layer menjadi satu layer baru tanpa 

analisis spasial. Merge berfungsi untuk menggabungkan data sejenis dan 

mengintegrasikan data dari berbagai sumber. Misalnya, menggabungkan data jalan 

dari beberapa wilayah menjadi satu layer. Ilustrasi Merge dapat dilihat pada gambar 

berikut. 

 

Dissolve digunakan untuk menggabungkan fitur berdasarkan atribut yang sama. 

Dissolve berfungsi untuk generalisasi data, dan menghilangkan batas internal. 

Misalnya, menggabungkan data desa menjadi kabupaten berdasarkan nama 

kabupaten. Ilustrasi Dissolve dapat dilihat pada gambar berikut. 

 

Sebagai Kesimpulan dan perbandingan, Buffer, Clip, Intersect, Union, Merge, dan 

Dissolve dapat dilihat pada Tabel berikut. 
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Tools Jenis Analisis Tujuan Utama 

Buffer Jarak Membuat zona pengaruh 

Clip Pembatasan Memotong area 

Intersect Overlay Mencari irisan 

Union Overlay Menggabungkan semua area 

Merge Non-spasial Menggabungkan layer 

Dissolve Atribut Menyederhanakan data 

 

Untuk menjalankan tools diatas, dapat dilakukan pada toolbar Geoprocessing.  
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BAB VI 

PENYAJIAN DAN OUTPUT PETA 

Tujuan: Mahasiswa mampu menyajikan hasil kerja 

 

Dalam menyajikan hasil peta, peta dapat disimpan dalam berbagai macam tipe data. 

Paling sering digunakan seperti JPG, atau PDF jika sudah final. Namun, jika ingin 

membagikan peta dalam bentuk yang masih bisa diedit oleh pengguna lain, dapat 

menyimpan dalam bentuk Map Package. 

A. Eksport Peta dalam bentuk JPG/PDF 

Untuk menyimpan peta dalam bentuk JPG/PDF, dapat dilakukan dengan klik toolbar 

File → Eksport Map … → Mengatur Nama, dan jenis data → Save. 

 

Save as type dapat dipilih sesuai kebutuhan. Pada gambar diatas, tipe yang dipilih 

adalah PDF. Resolusi dapat diatur hingga 300 dpi (disarankan) untuk cetak. Tampilan 

peta setelah dieksport menjadi PDF dapat dilihat pada gambar berikut. 



Page | 69  
 

 

 

B. Membuat Map Package 

Map Package berfungsi untuk membagikan project dengan mudah. Apabila 

membagikan dalam bentuk mxd atau arcmap project, semua isi data vector maupun 

raster yang ada didalamnya juga harus disertakan. Map Package mempermudah 

membagikan project tanpa perlu menyertakan seluruh isi data vector/raster secara 

terpisah. Untuk membuat Map Package, dapat dilakukan melalui File → Share As → 

Map Package. 
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Klik Share pada sudut kanan atas. 

 

Setelah sukses, Map Package dapat dibagikan.  

 

  

Mengubah 

penyimpanan file pada 

Save package to file 

Pada Item Description, 

terdapat beberapa 

kolom yang harus diisi, 

ditandai dengan tulisan 

required 
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RANGKUMAN 

 

1. Bab I: Pengenalan ArcGIS dan Konsep Dasar SIG 

Bab ini membahas konsep dasar Sistem Informasi Geografis (SIG) sebagai sistem 

berbasis komputer yang digunakan untuk mengelola, menganalisis, dan 

menampilkan data geografis. Dijelaskan pula bahwa ArcGIS merupakan perangkat 

lunak yang mendukung implementasi SIG dalam berbagai bidang seperti 

perencanaan wilayah dan penelitian. Selain itu, bab ini menjelaskan jenis data spasial 

yaitu data vektor (titik, garis, polygon) dan raster (berbasis piksel), beserta kelebihan 

dan kekurangannya. Bab ini juga memperkenalkan antarmuka ArcMap, termasuk 

menu, toolbar, dan fungsi dasar yang digunakan dalam pengolahan data spasial. 

2. Bab II: Pengoperasian Dasar ArcMap 

Bab ini menjelaskan keterampilan dasar dalam menggunakan ArcMap, seperti 

menambahkan data spasial (vektor dan raster) ke dalam workspace, mengatur layer 

pada Table of Contents, serta melakukan navigasi peta seperti zoom, pan, dan identify. 

Pengguna juga diperkenalkan dengan cara menghubungkan folder melalui Catalog 

dan mengelola tampilan layer agar analisis dapat dilakukan dengan lebih efektif. 

3. Bab III: Input dan Editing Data Spasial 

Bab ini membahas proses pembuatan dan pengeditan data spasial melalui digitasi. 

Dijelaskan konsep dasar digitasi untuk membuat data titik, garis, dan polygon, serta 

cara membuat shapefile baru dengan menentukan sistem koordinat. Selain itu, 

dijelaskan proses editing menggunakan fitur editor serta cara mengisi, menambah, 

dan mengelola tabel atribut. Bab ini menekankan pentingnya integrasi antara data 

spasial dan atribut dalam membangun informasi geografis yang lengkap. 

4. Bab IV: Pembuatan Peta Tematik 

Bab ini menjelaskan proses pembuatan peta tematik seperti peta kemiringan lereng 

dan curah hujan. Dijelaskan tahapan pengolahan data raster, mulai dari pengunduhan 

data DEM, proses mosaik, analisis slope, hingga reclassify dan konversi raster ke 

vektor. Selain itu, dijelaskan metode interpolasi curah hujan seperti Kriging serta 

proses input data dari Excel ke ArcMap. Bab ini juga membahas pembuatan layout 

peta sesuai kaidah kartografis, termasuk unsur-unsur peta seperti judul, legenda, 

skala, dan arah utara agar peta informatif dan mudah dipahami. 
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5. Bab V: Analisis Spasial Dasar 

Bab ini membahas konsep dan penerapan analisis spasial menggunakan tools 

Geoprocessing. Dijelaskan penggunaan query atribut untuk menyeleksi data 

berdasarkan tabel, serta analisis buffer untuk membuat zona jarak tertentu dari 

objek. Selain itu, dibahas pula operasi overlay seperti clip, intersect, union, serta tools 

lain seperti merge dan dissolve yang digunakan untuk menggabungkan atau 

menyederhanakan data. Bab ini menekankan pentingnya analisis spasial dalam 

menghasilkan informasi baru dari data geografis. 

6. Bab VI: Penyajian dan Output Peta 

Bab ini menjelaskan cara menyajikan hasil analisis dalam bentuk output peta. Peta 

dapat diekspor ke berbagai format seperti JPG dan PDF untuk keperluan publikasi, 

dengan pengaturan resolusi yang sesuai. Selain itu, dijelaskan pembuatan Map 

Package untuk membagikan proyek ArcMap secara lengkap tanpa harus mengirim 

data terpisah. Bab ini menekankan pentingnya penyimpanan dan distribusi hasil 

kerja secara sistematis dan profesional. 
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LATIHAN EVALUASI 

Soal Teori 

1. Jelaskan pengertian Sistem Informasi Geografis (SIG) dan peran ArcGIS dalam 

SIG! 

 

2. Apa perbedaan data vektor dan raster beserta contoh penggunaannya? 

 

3. Jelaskan langkah-langkah menambahkan data ke dalam ArcMap dan fungsi dari 

Add Data! 

 
 

4. Apa fungsi Table of Contents dan bagaimana cara mengatur layer di dalamnya?\ 

5. Jelaskan proses digitasi dalam ArcMap dan sebutkan tiga jenis data vektor yang 

digunakan! 
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6. Bagaimana cara menambahkan dan mengisi field pada tabel atribut? 

 

7. Jelaskan tahapan pembuatan peta kemiringan lereng dari data DEM! 

 

8. Apa fungsi interpolasi dalam pembuatan peta curah hujan dan mengapa metode 

Kriging digunakan? 

 

9. Jelaskan perbedaan antara query atribut dan buffer dalam analisis spasial! 

 

10. Apa perbedaan fungsi Clip, Intersect, dan Union dalam geoprocessing? 

 

11. Jelaskan langkah-langkah mengekspor peta menjadi format PDF atau JPG! 
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12. Apa itu Map Package dan apa kelebihannya dibandingkan file .mxd biasa? 

 

 

 

 

 

Tugas Praktik 

Buatlah Peta Kemiringan Lereng seperti contoh pada BAB IV Pembuatan Peta Tematik. 

Eksport peta dalam bentuk JPG.    
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